Legal Information

Book Name: AdminStudio 2018 R4 Evaluation Guide
Part Number: ADS-2018R4-EG00
Product Release Date: January 2019

Copyright Notice
Copyright © 2019 Flexera
This publication contains proprietary and confidential information and creative works owned by Flexera and its licensors, if any. Any use, copying, publication, distribution, display, modification, or transmission of such publication in whole or in part in any form or by any means without the prior express written permission of Flexera is strictly prohibited. Except where expressly provided by Flexera in writing, possession of this publication shall not be construed to confer any license or rights under any Flexera intellectual property rights, whether by estoppel, implication, or otherwise.
All copies of the technology and related information, if allowed by Flexera, must display this notice of copyright and ownership in full.

Intellectual Property
For a list of trademarks and patents that are owned by Flexera, see https://www.flexera.com/producer/company/about/intellectual-property/. All other brand and product names mentioned in Flexera products, product documentation, and marketing materials are the trademarks and registered trademarks of their respective owners.

Restricted Rights Legend
The Software is commercial computer software. If the user or licensee of the Software is an agency, department, or other entity of the United States Government, the use, duplication, reproduction, release, modification, disclosure, or transfer of the Software, or any related documentation of any kind, including technical data and manuals, is restricted by a license agreement or by the terms of this Agreement in accordance with Federal Acquisition Regulation 12.212 for civilian purposes and Defense Federal Acquisition Regulation Supplement 227.7202 for military purposes. The Software was developed fully at private expense. All other use is prohibited.
# Contents

**AdminStudio 2018 R4 Evaluation Guide**  ................................................................. 5

**Getting Started** ........................................................................................................ 7
  - About Evaluating AdminStudio ............................................................................. 7
  - Purpose of Evaluation Guide .................................................................................. 8
  - Organization of Evaluation Guide .......................................................................... 9
  - Evaluation Guide Data Files .................................................................................... 11

**New Features** ............................................................................................................ 12
  - Improvements in AdminStudio 2018 R4. ............................................................. 12
  - New Features in AdminStudio 2018 R3 .............................................................. 12
    - Extended Support for Microsoft MSIX Packages ........................................... 12
    - Converting Existing (MSI & EXE) Packages to MSIX using Repackager ....... 12
    - Digital Signing of MSIX Package ...................................................................... 13
    - Testing the Conversion Compatibility before Converting to MSIX .................. 13
    - Wrapping MSI/EXE Packages to WiseScript-Wrapped EXEs ....................... 13
    - Support for Vendor Command Line Arguments .......................................... 13
    - Support for ESXi during Conversion Using vSphere APIs .............................. 14
    - Support for Publish of MSI Applications with MSTs to VMware Workspace ONE ........................................................................................................ 14
  - New Features in AdminStudio 2018 R2 .............................................................. 14
    - Support for Microsoft MSIX Packages .......................................................... 14
      - Importing Microsoft MSIX Packages into the Application Catalog .......... 14
      - Testing Windows Installer Packages for MSIX Conversion Compatibility .... 15
    - User Interface Modernization .......................................................................... 15
  - New Features in AdminStudio 2018 .............................................................. 15
    - Application Manager User Interface Redesign ................................................. 15
      - Redesigned Ribbon Interface ...................................................................... 16
      - Updated Deployment Type, Status, and Subnode Icons .............................. 17
      - New Pie Chart Display on Group View of Analyze Tab .............................. 18
      - New Supportability Risks Test Category Groups ......................................... 19
      - Simplified Compatibility Test Results ......................................................... 20
AdminStudio makes short work of application deployment chores such as updates, new releases, new applications, and Windows 10 migrations. More than a packaging tool, AdminStudio arms your IT team with a complete application readiness solution, enabling you to identify and mitigate issues before pulling the deployment trigger. No more surprises.

With AdminStudio, you can:

- Improve service quality and streamline service delivery
- Decrease risk and embrace new technologies faster
- Eliminate mobile application security and compatibility concerns
- Reliably prepare and deploy application virtualization formats
- Integrate seamlessly with leading software deployment systems
- Simplify and unify application management with standardized processes
- Boost efficiency with a central application repository
- Identify application packaging issues in minutes instead of days

AdminStudio 2018 introduces App Risk Module to keep you aware of application vulnerabilities from packaging to deployment. Don’t let application vulnerabilities open the door to business risk. Add App Risk Module to your AdminStudio implementation to:

- Take a proactive approach to your cybersecurity defenses so your business doesn’t fall victim to ransomware or the next big cybersecurity threat
- Make early vulnerability assessment and remediation integral to your Application Readiness process
- Stay on top of vulnerabilities with regularly scheduled, automatic scans against Flexera’s extensive list of application titles
- Keep up on the fixes and patches available for known vulnerabilities so you can implement them early to minimize risk
You can use this Evaluation Guide to quickly learn how to use AdminStudio to prepare Windows Installer, virtual applications, web applications, macOS desktop applications, and mobile applications for deployment. This Evaluation Guide is organized into the following sections:

**Table 1 • AdminStudio 2018 R4 Evaluation Guide**

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Getting Started</td>
<td>Explains what is included in this Evaluation Guide and how to get started.</td>
</tr>
<tr>
<td>New Features</td>
<td>Provides an overview of the new features in AdminStudio 2018 R4.</td>
</tr>
<tr>
<td>Setting Up AdminStudio Infrastructure</td>
<td>Explains how to perform the one-time set-up tasks that you need to complete prior to using AdminStudio including creating an Application Catalog, configuring a virtual machine, configuring e-mail settings, and specifying server connection settings.</td>
</tr>
<tr>
<td>Migrating to Windows Installer</td>
<td>Explains how to convert a sample setup to a Windows Installer package, import it into the Application Catalog, test it for operating system compatibility, best practices, and conflicts, and then prepare it for distribution.</td>
</tr>
<tr>
<td>Migrating to Application Virtualization</td>
<td>Explains how to use the Automated Application Converter to convert Windows Installer packages to virtual packages, and then test and distribute the virtual packages.</td>
</tr>
<tr>
<td>Testing for Application Compatibility</td>
<td>Explains how to use Application Manager to test packages for compatibility with the latest versions of Microsoft Windows, Windows Server, macOS, Apple iOS, Google Android, and Windows Phone operating systems, as well as to test web applications for compatibility with Internet Explorer 11 and Microsoft Edge.</td>
</tr>
</tbody>
</table>
Getting Started

This section explains what is included in this Evaluation Guide and how to get started:

- About Evaluating AdminStudio
- Purpose of Evaluation Guide
- Organization of Evaluation Guide
- Evaluation Guide Data Files

About Evaluating AdminStudio

You can choose to evaluate AdminStudio for 21 days. By clicking Continue to Evaluate AdminStudio dialog box that opens when you launch AdminStudio, you can begin evaluating the AdminStudio Enterprise Edition client tools.

Information about evaluating the AdminStudio client tools includes the following topics:

- AdminStudio Client Tools Evaluation Restrictions
- Evaluating AdminStudio’s Microsoft App-V Support
- Evaluating the Automated Application Converter “Multiple Application” Option

AdminStudio Client Tools Evaluation Restrictions

When you run AdminStudio in trial/evaluation mode, all of its features are fully available, with the following restrictions:

- Can create only one Application Catalog—You are permitted to create only one Application Catalog, and it must be named AdminStudio Evaluation Catalog.
- Ten package import limit—Only 10 total packages (of one or more deployment types) can be imported into the Application Catalog.
- Package deletion not permitted—After you import a package into the Application Catalog, you are not permitted to delete it.
- AdminStudio Platform API support is disabled—All platform support is disabled.

Evaluating AdminStudio’s Microsoft App-V Support

While evaluating the AdminStudio Enterprise Edition client tools, you will be able to convert a Windows Installer package to an App-V application using the Automated Application Converter, Conversion Wizard, Repackager, and the InstallShield App-V Assistant. However, an App-V application built using an evaluation version of AdminStudio will display the following message every time it is launched:

![This package was created with an evaluation version of InstallShield](image)

**Figure 1:** Evaluation Version Message

After activating AdminStudio, you will be able to remove this message by rebuilding the App-V application.
Evaluating the Automated Application Converter “Multiple Application” Option

The Multiple Application option of Automated Application Converter is only available when you purchase AdminStudio Enterprise Edition.

Note • With AdminStudio Standard or Professional Editions, you will only be able to convert one package at a time, using one virtual machine.

When using an evaluation version of AdminStudio, you will be able to use Automated Application Converter to convert a directory full of Windows Installer packages into individual virtual packages, but the conversion will be limited to three packages per run, using only one virtual machine. Therefore, only the first three packages that Automated Application Converter encounters will be converted to virtual applications.

Purpose of Evaluation Guide

The purpose of this Evaluation Guide is to help system administrators and other reviewers learn how to quickly get started using AdminStudio to prepare Windows Installer and virtual applications for deployment. By performing the exercises in this Evaluation Guide using the provided data files, you will learn how to:

- Create an Application Catalog
- Repackage a sample package
- Import packages into the Application Catalog
- Test Windows Installer packages, App-V packages, and web applications
- Configure a virtual machine for use in automated repackaging
- Convert Windows Installer packages to virtual applications
- Distribute Windows Installer and App-V packages
- Perform operating system compatibility and browser compatibility testing
# Organization of Evaluation Guide

This Evaluation Guide provides exercises that guide you through performing the following key procedures:

<table>
<thead>
<tr>
<th>Procedure</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>Setting Up AdminStudio Infrastructure</td>
<td>In these set of exercises, you will perform the one-time setup tasks that are necessary to get started using AdminStudio:</td>
</tr>
<tr>
<td></td>
<td>• Creating an Application Catalog</td>
</tr>
<tr>
<td></td>
<td>• Configuring a Virtual Machine</td>
</tr>
<tr>
<td></td>
<td>• Setting E-Mail Notification Settings</td>
</tr>
<tr>
<td></td>
<td>• Entering Server/Database Connection Settings</td>
</tr>
<tr>
<td>Migrating to Windows Installer</td>
<td>In this set of exercises, you will migrate a sample setup (such as an .exe file) to a deployable Windows Installer package (.msi):</td>
</tr>
<tr>
<td></td>
<td>• Repackaging a Sample Package</td>
</tr>
<tr>
<td></td>
<td>• Importing Packages into the Application Catalog</td>
</tr>
<tr>
<td></td>
<td>• Testing a Repackaged Application and Resolving Issues</td>
</tr>
<tr>
<td></td>
<td>• Distributing a Repackaged Application</td>
</tr>
<tr>
<td>Migrating to Application Virtualization</td>
<td>In this set of exercises, you will migrate a set of applications into virtual applications that are ready for deployment:</td>
</tr>
<tr>
<td></td>
<td>• Identifying Packages to Virtualize</td>
</tr>
<tr>
<td></td>
<td>• Converting to Virtual Formats</td>
</tr>
<tr>
<td></td>
<td>• Testing and Distributing Converted Packages</td>
</tr>
<tr>
<td>Testing for Application Compatibility</td>
<td>In this set of exercises, you will test Windows Installer packages for application readiness on the latest versions of Microsoft Windows and Windows Server. You will also test web applications for compatibility with Internet Explorer 11 and Microsoft Edge.</td>
</tr>
<tr>
<td></td>
<td>• Importing Packages, Web Applications, and Mobile Apps</td>
</tr>
<tr>
<td></td>
<td>• Selecting Tests to Run and Setting Default Fix Option</td>
</tr>
<tr>
<td></td>
<td>• Performing Testing and Viewing Results</td>
</tr>
</tbody>
</table>
These four main procedures are also featured on AdminStudio’s Start Page.

Figure 2: AdminStudio Start Page
Each subtab of the Start Page includes a flowchart that lists the steps in each procedure. For example, the following flowchart is displayed on the **Migrate to Windows Installer** tab:

![Flowchart](image)

**Figure 3:** Migrate to Windows Installer Tab of AdminStudio Start Page

### Evaluation Guide Data Files

To perform the exercises in the AdminStudio Evaluation Guide, you will be using the sample data that is provided in the `AS2018EvalGuideDataFiles.zip` file. These data files are organized into the following directories:

- SampleApplicationSetup
- SampleApplicationSource
- SampleApplicationTarget
- SampleKit

**Figure 4:** Directory Structure of AdminStudio Evaluation Guide Data Files

These data files demonstrate the recommended organizational structure that you should use when you want to import a directory of packages into the Application Catalog:

- **One root directory**—Organize the packages you want to import in one root directory (`AS2018EvalGuideDataFiles` in this example).
- **Each application in a subdirectory**—Each application should be stored in its own first level subdirectory (such as `SampleKit` or `SampleApplicationTarget`).
- **Each deployment type in a sub-subdirectory**—Each deployment type should be stored in its own sub-subdirectory (`AppV`, `MSI`, etc.) of the application directory.

Unzip this data file and place its contents in a location accessible to your installation of AdminStudio, such as:

`C:\AS2018EvalGuideDataFiles`
New Features

This section describes the new features in the releases of AdminStudio 2018:

- Improvements in AdminStudio 2018 R4
- New Features in AdminStudio 2018 R3
- New Features in AdminStudio 2018 R2
- New Features in AdminStudio 2018

Improvements in AdminStudio 2018 R4

In previous releases, under some situations, Repackager failed to function as expected. In AdminStudio 2018 R4, this issue has been resolved.

New Features in AdminStudio 2018 R3

This section lists the new features that are included in AdminStudio 2018 R3:

- Extended Support for Microsoft MSIX Packages
- Wrapping MSI/EXE Packages to WiseScript-Wrapped EXEs
- Support for Vendor Command Line Arguments
- Support for ESXi during Conversion Using vSphere APIs
- Support for Publish of MSI Applications with MSTs to VMware Workspace ONE

Extended Support for Microsoft MSIX Packages

Microsoft has introduced a new installer technology, MSIX packages (.msix), to support platform independent installations.

In AdminStudio 2018 R3, there is an extended support to this new MSIX deployment type.

Converting Existing (MSI & EXE) Packages to MSIX using Repackager

In AdminStudio 2018 R3, you can now convert your existing (MSI & EXE) packages to MSIX using repackager and Digitally sign them using the Microsoft Sign tool.
Digital Signing of MSIX Package

In AdminStudio 2018 R3, you can now digitally sign the MSIX package in the application catalog. The Sign Package option is available at the MSIX package context menu level.

Either by using the pfx file or by the subject name, you can digitally sign the selected app package using the Sign tool.

Testing the Conversion Compatibility before Converting to MSIX

In AdminStudio 2018 R3, you can scan and test whether or not the package has shortcuts for MSIX conversion.

Wrapping MSI/EXE Packages to WiseScript-Wrapped EXEs

In AdminStudio 2018 R3, you can now wrap MSI/EXE packages to WiseScript-wrapped EXEs.

You can wrap MSI/EXE packages to WiseScript-wrapped EXEs using the Wrap Package Wizard. You can use the Wrap Options to select the wrap types.

You will be provided with a default template location and a wrapped package output directory which will help you wrap the packages.

Support for Vendor Command Line Arguments

AdminStudio 2018 R3 provides command line arguments for silent installation and uninstallation while importing any exe package into the Application Catalog. You can also modify the suggested command line arguments.

Some of the exe package types require the uninstaller for uninstallation. These are the different types of exe packages that require uninstallers:

- InstallAnywhere
- WiseScript
- NullSoft
- InnoSetup
Support for ESXi during Conversion Using vSphere APIs

In AdminStudio 2018 R3, the VIX APIs for ESXi host versions below 5.5 are not supported any longer. There are new vSphere APIs which are added to support the Virtual Machine guest operations. The VIX APIs are replaced by vSphere APIs.

The new vSphere APIs are consumed to perform any Virtual Machine operations while the virtualization is been performed using AAC.

Support for Publish of MSI Applications with MSTs to VMware Workspace ONE

In AdminStudio 2018 R3, you can publish MSI along with its transforms (MSTs) to VMware Workspace ONE. AirWatch is now referred as Workspace ONE.

This is an extension to AdminStudio's existing capability of publishing IPA (iOS) and APK (Android) packages to Workspace ONE.

New Features in AdminStudio 2018 R2

This section lists the new features that are included in AdminStudio 2018 R2:

- Support for Microsoft MSIX Packages
- User Interface Modernization

Support for Microsoft MSIX Packages

Microsoft has introduced a new installer technology, MSIX packages (.msix), to support platform independent installations. AdminStudio 2018 R2 supports this new MSIX deployment type.

MSIX is the next generation software deployment model for the Windows platform, bringing the best of MSI, AppX and App-V together in a single package. MSIX has the capability to run a traditional Win32 application in a native container, achieving application isolation, ease of deployment, fully clean uninstallation, and seamless software updates all at the same time. MSIX promises to be the alternative to MSI and become the gold standard of Windows deployments. You can choose to continue to use MSI, but the benefits of MSIX will greatly outweigh the need to maintain MSIs long-term, especially given that most enterprises and consumers are increasing their adoption of Windows 10.

Importing Microsoft MSIX Packages into the Application Catalog

AdminStudio 2018 R2 supports the import of Microsoft MSIX packages (.msix) into the Application Catalog.

To import an .msix package into the Application Catalog, select Microsoft MSIX Package (.msix) on the Package Type Selection panel of the Import Wizard.
Testing Windows Installer Packages for MSIX Conversion Compatibility

In AdminStudio 2018 R2, you can test the Windows Installer (.msi) packages in your Application Catalog for compatibility for conversion to MSIX package format.

When a Windows Installer package is tested during import or by clicking the Execute Tests button on the Analyze tab, the MSIX conversion compatibility tests are run. You can view an icon indicating the status of the test results in the Supportability Risks column of the Analyze Application View and Analyze Group View. Detailed test results can be viewed by clicking on the MSIX Conversion Compatibility status icon on the Supportability Risks tab of the Analyze Deployment Type View.

There is also a new MSIX Conversion Compatibility report on the Reports tab. This report identifies each application in the Application Catalog as either Recommended for conversion to the MSIX package format or Not Recommended.

User Interface Modernization

AdminStudio’s splash screens and About dialog boxes have been updated to match the redesigned user interface.

New Features in AdminStudio 2018

This section lists the new features that are included in AdminStudio 2018:

- Application Manager User Interface Redesign
- Consolidation of Functionality in Application Manager
- Legacy Add-On Packs Now Included with Professional and Enterprise Editions
- InstallShield 2018

Application Manager User Interface Redesign

In AdminStudio 2018, the Application Manager user interface has been redesigned and updated to provide a clean, modern look that makes it easy to navigate through application readiness tasks.

- Redesigned Ribbon Interface
- Updated Deployment Type, Status, and Subnode Icons
- New Pie Chart Display on Group View of Analyze Tab
- New Supportability Risks Test Category Groups
- Simplified Compatibility Test Results
Redesigned Ribbon Interface

The look and feel of AdminStudio’s ribbon interface has been updated with new icons, and the names of the tabs have been changed to more clearly reflect their purpose.

**Home Tab**

The ribbon on the Application Manager [Home tab](#) (previously named the [Catalog tab](#)) contains buttons that enable you to import packages into the Application Catalog, edit Windows Installer and virtual packages, and distribute applications. You can also launch other AdminStudio tools by clicking on the [AdminStudio Tools button](#).

![Home Tab Ribbon](#)

**New Feedback Button**

The ribbon on the AdminStudio [Home tab](#) now includes a new [Feedback button](#) that you can use to provide feedback and ideas about AdminStudio tools. When you click the [Feedback button](#), the Flexera Customer Community [Ideas page](#) opens, where you can post new ideas and browse ideas submitted by other users. If you like a posted idea, you can vote for it, and even add comments.

![Flexera Customer Community Ideas Page](#)
**Analyze Tab**

The ribbon on the Application Manager **Analyze** tab (previously named the **Test Center** tab) contains buttons that enable you to perform all testing tasks.

![Analyze Tab Ribbon](image)

**Figure 7:** Analyze Tab Ribbon

**Reports Tab**

The ribbon on the Application Manager **Reports** tab (previously named the **Report Center** tab) contains buttons that enable you to view all available reports.

![Reports Tab Ribbon](image)

**Figure 8:** Reports Tab Ribbon

**Support Tab**

The ribbon on the Application Manager **Support** tab contains buttons that give you access to application information, the online help library, and the release notes. A new **Check for Updates** button has been added to make it easy to see if any updates are available for AdminStudio.

![Support Tab Ribbon](image)

**Figure 9:** Support Tab Ribbon

**Updated Deployment Type, Status, and Subnode Icons**

All deployment type, test status, and subnode icons have been updated to give Application Manager a refreshed look. For example, the following image displays a few deployment type icons that have been redesigned.

![Updated Icons](image)

**Figure 10:** Redesigned Deployment Type Icons
New Pie Chart Display on Group View of Analyze Tab

In previous releases, the **Group View** of the **Analyze** tab (formerly **Test Center**) tab just listed summary icons of the test results for all applications in the group, similar to the following image.

![Figure 11: Group View / List Format](image)

In AdminStudio 2018, a new toggle button has been added to the top right side of this screen that enables you to switch to a graphical view of this same data.

![Figure 12: Toggle Button](image)
When you click the toggle button, you can switch between the standard list format and a new graphical, pie chart view.

![Group View / Chart Format](image)

**Figure 13:** Group View / Chart Format

On the Chart view, you can make selections from the drop down lists to filter each pie chart by various criteria: operating systems, virtual format, dependencies, or vulnerability type.

### New Supportability Risks Test Category Groups

On the **Analyze** tab, in order to separate standard compatibility, best practices, conflict test results, all previously existing test categories have been grouped under the new **Supportability Risks** header.

![Supportability Risks Test Category Groups](image)

**Figure 14:** Supportability Risks Test Category Groups
Simplified Compatibility Test Results

In previous releases, when you viewed compatibility, best practices and risk assessment test results, a large list of numbers—identifying how many tests were executed, how many errors/warnings were generated, etc.—were displayed for each test. To view details of a particular test, you had to open a subtab, such as Operating System Compatibility, where test results for all of the tests in that category were listed.

![Figure 15: Summary Deployment Type Test Results In Previous Releases](image1)

In AdminStudio 2018, a cleaner view of test results is displayed, with only a summary status icon displayed for each test. To see the detailed results for a specific test, you can now just click on that test to open the detailed view.

![Figure 16: Summary Deployment Type Test Results In AdminStudio 2018](image2)
On the detailed test results view for an individual test, such as **Windows 10 64-bit** as shown in the following image, the test statistics are listed in color-coded boxes at the top of the view. To return to the Summary view, you just click on the back arrow to the left of the test name.

*Figure 17: Detailed Deployment Type Test Results for an Individual Test*
Consolidation of Functionality in Application Manager

In AdminStudio 2018, the focus has shifted to make Application Manager the central application in the entire AdminStudio toolkit. As demonstrated in the following diagram, all application readiness tasks can be either performed using Application Manager or launched from it.

*Figure 18: Application Manager Application Readiness Workflow*
Ability to Launch AdminStudio Tools from Application Manager Home Tab

You can now launch other AdminStudio tools from the Application Manager Home tab by clicking the AdminStudio Tools button and making a selection from the menu.

![AdminStudio Tools Menu in Application Manager](image)

Figure 19: AdminStudio Tools Menu in Application Manager

Legacy Add-On Packs Now Included with Professional and Enterprise Editions

Starting with AdminStudio 2018, AdminStudio Professional and Enterprise Editions now include all of the features that were previously only available in the Virtualization, Application Compatibility, and Mac and Mobile add-on packs.

Starting with AdminStudio 2018, all virtualization, application compatibility, and Apple / macOS features are now available in Professional and Enterprise Editions at no extra cost. For a detailed breakdown of the features in the various AdminStudio editions, see the AdminStudio 2018 Release Notes.

InstallShield 2018

AdminStudio 2018 includes InstallShield 2018. For a complete list of new features in InstallShield 2018, see the InstallShield 2018 Release Notes.
Setting Up AdminStudio Infrastructure

The flowchart on the **Set Up Infrastructure** tab of the AdminStudio Start page lists the steps you need to perform before you can get started using AdminStudio.

Figure 20: Set Up Infrastructure Tab of AdminStudio Start Page

These are specific one-time set-up tasks that you need to perform prior to using AdminStudio. To set up AdminStudio infrastructure, perform the following exercises:

- Creating an Application Catalog
- Configuring a Virtual Machine
- Setting E-Mail Notification Settings
- Entering Server/Database Connection Settings

Creating an Application Catalog

With AdminStudio, you manage your applications and their deployment types in an Application Catalog database, which stores all package information, including test results. This enables you to perform enterprise level data checking. You can share your Application Catalog between multiple AdminStudio users.

AdminStudio and many of its tools (such as Application Manager) require you to be connected to an Application Catalog, while others give you the option of working with packages on a local or network directory or from Microsoft System Center Configuration Manager Server.
In this exercise, you will create a new AdminStudio Application Catalog and set it as the default.

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Create an Application Catalog</td>
<td>Open AdminStudio and create a new SQL Server Application Catalog database named AdminStudio Evaluation Catalog, as described in Creating New Application Catalogs Using the AdminStudio Interface.</td>
<td>AdminStudio is open and connected to a new Application Catalog named AdminStudio Evaluation Catalog.</td>
</tr>
</tbody>
</table>

*Note* - On the Select Software Repository Location panel of the Application Catalog Wizard, do NOT select the Enable Software Repository option.

### Configuring a Virtual Machine

Virtual machines are used by Automated Application Converter during automated repackaging (performed during conversion to virtual applications) and when testing applications.

You need to prepare each virtual machine that you are going to use with the Automated Application Converter to perform automated repackaging or testing by doing the following:

- **Run Virtual Machine Preparation setup**—On each virtual machine you are going to use with the Automated Application Converter, run the Virtual Machine Preparation setup, an application that will enable automatic login. You need to run this application one time on all of the virtual machines that you are going to use with the Automated Application Converter.

- **Create a snapshot**—After you have run the Virtual Machine Preparation setup on a virtual machine, you need to shut it down and create a snapshot named AutoRepack_Base. This enables the Automated Application Converter to revert the virtual image to a clean state after each repackaging run.

- **Install VMware VIX API (VMware only)**—In order for the Automated Application Converter to perform automated repackaging, it needs to communicate with the virtualization technology that you are using. If you are using VMware virtualization technology (VMware ESX or ESXi Server or a local VMware Workstation 6.5 or later), you need to have the VMware VIX API installed on the same machine as the Automated Application Converter.
In this exercise, you will configure a virtual machine for use with Automated Application Converter.

Table 4 • Configure Virtual Machines

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Run Virtual Machine Preparation setup to enable auto login</td>
<td>On a Microsoft Hyper-V Server image, VMware ESX/ESXi Server image, or VMware Workstation (6.5+) image, run the virtual machine preparation setup.</td>
<td>When you restart the virtual machine image, you are automatically logged in and GuestAgent.exe is launched.</td>
</tr>
</tbody>
</table>

![Auto Repackager Configuration - InstallShield Wizard](image1)

**Note** • For instructions, see Preparing Your Virtual Machines for Use With the Automated Application Converter.

| 2  | Create a snapshot for repackaging | On the prepared virtual image, create a clean snapshot named AutoRepack_Base. | A clean snapshot named AutoRepack_Base exists on the virtual machine. |

![Automated Application Converter - Guest Agent](image2)

**Note** • For instructions, see Taking a Snapshot in Preparing Your Virtual Machines for Use With the Automated Application Converter.
### Table 4 • Configure Virtual Machines

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Install VMware VIX</td>
<td>If you are using a VMware ESX/ESXi Server or VMware Workstation image, you need to install the VMware VIX API on the AdminStudio machine.</td>
<td>The VMware VIX API is installed successfully.</td>
</tr>
</tbody>
</table>

To install the VMware VIX API on the AdminStudio machine, do one of the following:

- Install VMware Workstation on the AdminStudio machine.
- Download and install the VMware VIX API on the AdminStudio machine. You can download the VMware VIX API from the following location:


**Note** • For instructions, see VMware VIX API Requirement.
Table 4 • Configure Virtual Machines

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.</td>
<td>Add a virtual machine to Automated Application Converter</td>
<td>Open Automated Application Converter by clicking <strong>Add Virtual Machines</strong> on the <strong>Set Up Infrastructure</strong> tab of the AdminStudio Start page. The <strong>Application Conversion Project Wizard</strong> opens. Cancel the wizard. Then open the <strong>Machines</strong> tab and follow the instructions in <strong>Adding Virtual Machines Using the Virtual Machine Import Wizard</strong> to add the prepared virtual machine to the <strong>Machines</strong> tab.</td>
<td>A virtual machine is listed on the <strong>Machines</strong> tab of Automated Application Converter.</td>
</tr>
</tbody>
</table>

Note • When prompted, save the Automated Application Converter project file to the following directory:

C:\Users\YOURNAME\Documents\MyProject.aacx

All of the connection information for the virtual machine that you have set up is stored in the project file, so remember the name and location of your Automated Application Converter project file.

---

### Setting E-Mail Notification Settings

To enable AdminStudio to send you e-mail notifications during various processes, you need to configure your SMTP notification settings.

Currently, e-mail notifications are sent when soft time-outs are encountered while using Automated Application Converter to repackage an application on a virtual machine.

In this exercise, you will enter the SMTP settings for e-mail notifications. This enables AdminStudio to send notifications when a soft time out is encountered during repackaging on a virtual machine by Automated Application Converter.

Table 5 • Set E-Mail Notification Settings

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Set SMTP Notification Settings</td>
<td>On the <strong>Notification Settings</strong> tab of the <strong>AdminStudio Options</strong> dialog box, enter your SMTP settings for e-mail notifications.</td>
<td>When you click <strong>Test</strong> on the <strong>Notifications Settings</strong> tab, a successful message opens.</td>
</tr>
</tbody>
</table>

Note • For instructions, see **Setting E-Mail Notification Settings**.
Entering Server/Database Connection Settings

In AdminStudio 2018 R4, you can define multiple named connections to System Center Configuration Manager, Citrix XenApp, Symantec Altiris Client Management Suite, Microsoft Server App-V, JAMF Casper Suite, and AirWatch distribution systems. This enables you to both have multiple connections easily available during import and distribution, and to refer to those connection settings by name in Platform API commands.

You need to specify at least one named connection to a distribution system in order for Application Manager to import packages, distribute applications, or report on application deployment status.

To enable AdminStudio to display data from your Microsoft ACT (Application Compatibility Toolkit) database in views and reports, you need to enter connection information for your Microsoft ACT database.

### Table 6 • Enter Server Connection Settings

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Enter System Center Configuration Manager connection settings</td>
<td>Open the Application Manager <strong>Options</strong> dialog box, and on the <strong>Distribution System</strong> tab, create a named connection to System Center 2012 Configuration Manager.</td>
<td>When you click <strong>Test</strong> on the <strong>Distribution System</strong> tab, the following message is displayed: Connection to <strong>ServerName</strong> Succeeded</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong> For instructions, see <a href="#">Creating a New Distribution System Connection Setting</a></td>
<td></td>
</tr>
<tr>
<td>2.</td>
<td>Entering Microsoft ACT database connection settings</td>
<td>Open the Application Manager <strong>Options</strong> dialog box, and on the <strong>Microsoft ACT</strong> tab, enter Microsoft ACT database connection information.</td>
<td>When you click <strong>Test</strong> on the <strong>Microsoft ACT</strong> tab, a successful message opens: Connection to Microsoft ACT database successful!</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong> For instructions, see <a href="#">Entering Microsoft ACT Database Connection Settings</a></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong> This is an optional step that you can perform if your organization has a Microsoft ACT database and you want to display that data in Application Manager.</td>
<td></td>
</tr>
</tbody>
</table>
Migrating to Windows Installer

The flowchart on the **Migrate to Windows Installer** tab of the AdminStudio Start page lists the steps you need to perform to migrate a sample setup (such as an .exe file) to a deployable Windows Installer package.

![Flowchart](image)

**Figure 21:** Migrate to Windows Installer Tab of AdminStudio Start Page

In this section, you will convert a sample setup named SampleApplicationSetup.exe to a Windows Installer Package, import it into the Application Catalog, test it for best practices, operating system compatibility, and application conflicts, and then prepare it for distribution using Distribution Wizard.

**Important** • It is preferable to repackage 32-bit applications on 32-bit operating systems. In this exercise, we will be repackaging a 32-bit application.

To migrate a sample application to a Windows Installer package, perform the following steps:

- Repackaging a Sample Package
- Importing Packages into the Application Catalog
- Testing a Repackaged Application and Resolving Issues
Repackaging a Sample Package

In this procedure, you will repackage a sample setup, perform some minor edits in Repackager, and then build a Windows Installer package.

Table 7 • Repackage a Sample Package

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Select and repackage a sample package (.exe) to a Windows Installer Package (.msi)</td>
<td>Use Repackaging Wizard (Installation Monitoring method) to repackage the following sample setup: C:\AS2018EvalGuideDataFiles\SampleApplicationSetup\SampleApplicationSetup.exe</td>
<td>The captured data was converted into a Repackager project file (SampleApplication.irp) and opened in the Repackager interface.</td>
</tr>
<tr>
<td>2.</td>
<td>Important • It is recommended that you repackage this sample package on a clean machine. Save the captured data in the following directory: C:\Packages</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Note • For instructions, see Repackaging Using the Installation Monitoring Method.
### Table 7 • Repackage a Sample Package

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>3.</td>
<td>Edit package in Repackager and build Windows Installer package</td>
<td>To exclude files that are not part of the package, open the <strong>Files and Folders</strong> view, right-click on the <strong>[WindowsVolume]</strong> folder and select <strong>Exclude All</strong> from the context menu. Click <strong>Save</strong>.</td>
<td>The <strong>[WindowsVolume]</strong> folder is displayed in red to indicate that it is excluded:</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong> • For instructions, see <a href="#">Excluding All Files in a Directory</a>.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Open the <strong>Repackaged Output</strong> view and click <strong>Build</strong> to build a Windows Installer package.</td>
<td>The Repackager project file has been converted to a Windows Installer package, located in the following directory:</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong> • For instructions, see <a href="#">Building a Windows Installer Package</a>.</td>
<td>C:\Packages\MSI_Package\SampleApplication.msi</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Copy all of the files in the <strong>C:\Packages\MSI_Package</strong> directory (including the <strong>SampleApplication.msi</strong> file) to the following directory on the machine where AdminStudio is installed:</td>
<td>New Windows Installer package (and other associated files) are now in the same main directory as the other evaluation data files.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>*<em>C:\AS2018EvalGuideDataFiles\SampleApplicationSetup*</em></td>
<td></td>
</tr>
</tbody>
</table>
Importing Packages into the Application Catalog

In this procedure, you will import Windows Installer packages into the Application Catalog, including the one you created in Repackaging a Sample Package:

Table 8 • Import Into Application Catalog

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Result</th>
</tr>
</thead>
</table>
| 4. | Import Windows Installer package into Application Catalog | Before beginning import, open the Application Manager Options dialog box and clear the selection of the Automatically Execute Tests After Import option. Next, use the Import Wizard to import all of the packages in the AS2018EvalGuideDataFiles directory.  
  - On the Source panel, select Folder of multiple applications.  
  - On the Package Type Selection panel, select the Microsoft Windows Installer package (.msi) option  
  - On the Package Folder Selection panel, select the C: \ AS2018EvalGuideDataFiles directory.  
  - On the Select Applications panel, leave all of the applications selected.  
  - On the Destination Group panel, select the Applications folder in the tree. Do not select the Create subgroups based on source folder structure option. | The packages are now listed in the Application Manager tree, each under its own Application node:  
  ![Applications](image)  
  - Sample Application  
  - Sample Application (.iso)  
  - Sample Application Source  
  - Sample Application Source (.100.000)  
  - Sample Application Target  
  - Sample Application Target (.100.000)  
  - Sample Kit  
  - Sample Kit (.17.10.000)  
  
Note • For instructions on how to import a directory of packages into the Application Catalog, see Importing a Folder of Multiple Packages. |
### 4. Import Windows Installer package into Application Catalog (Continued)

Create a new group in the Application Manager tree named Engineering and move the **Sample Application** into that new group.

**Note** • For instructions, see Adding Groups and Organizing Applications in Application Manager.

<table>
<thead>
<tr>
<th>Step</th>
<th>Instructions</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>4.</td>
<td>Create another new group in the Application Manager tree named Marketing, and move the other three applications into that group.</td>
<td>The Application Manager tree should now be organized as follows:</td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Application Manager diagram" /></td>
<td><img src="image" alt="Application Manager diagram" /></td>
</tr>
</tbody>
</table>
Testing a Repackaged Application and Resolving Issues

In this procedure, you will test the Windows Installer packages you imported into the Application Catalog, and then distribute a package to a network location.

Table 9 • Test and Distribute Repackaged Applications

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>5</td>
<td>Perform Windows Installer best practices and OS compatibility testing</td>
<td>To perform Windows Installer best practices and operating system compatibility testing on all of the packages in the Application Catalog, first select the Analyze tab in the Application Manager ribbon. Then, select the Applications group in the Application Manager tree, and click Execute Tests.</td>
<td></td>
</tr>
</tbody>
</table>

*Note* • For more information, see *Performing Compatibility and Best Practices Testing.*

When testing is finished, view the test results by selecting a Windows Installer package in the tree to open the Summary view on the Supportability Risks tab of the Analyze Deployment Type View, as shown below:

![Summary view](image)

On Analyze tab views, groups, applications, and packages are assigned a test status in each test group using status icons. For packages, the status icon identifies that package’s test status (as described in About Status Icons). For groups and applications, Application Manager considers all of the packages in that group or application, and displays the status icon for the package that has the status at the highest hierarchical level, as described in the Hierarchical Level of Status Icons section of the About Status Icons help topic.

*Note* • For more information, see Viewing Summary Test Results.
6. Perform application conflict testing

Use the Conflict Wizard to detect conflicts between the following two packages:

- **Source**: Sample Application Source
- **Target**: Sample Application Target

*Note* • For instructions, see *Testing for Conflicts Between Packages*.

7. Review test results

When application conflict testing is finished, view the test results by selecting the Sample Application Source MSI package in the tree, and then clicking on *Windows Installer Conflicts* under *Application Conflicts* on the *Supportability Risks* tab of the *Analyze Deployment Type View*. Errors and warnings are listed. Click the plus sign next to a test name to view individual error/warning messages for that package:

![Supportability Risks screen](image)

Next, click the suppress (ON/OFF) button next to the **Identical Merge Modules** error to suppress that test from test totals and from automatic resolution. The button toggles to the OFF position and the error icon turns to gray.

*Note* • For more information, see the following topics:

- Viewing Detailed Package Test Results
- Viewing Application Conflicts Test Results
- Filtering Test Results by Suppressing Errors/Warnings
8. **Perform automatic issue resolution**

Issues for which automatic fixes are available are identified by the Error With Fix or Warning With Fix icon:

![Error and Warning Icons](image)

To automatically resolve all issues for which automatic fixes are available, select the **Applications** group node in the tree and click **Resolve Issues** on the **Analyze** tab of the ribbon.

**Note** • For more information, see **Performing Automatic Issue Resolution**.

Issue resolution begins, progress messages appear in the Output window, and Application Manager performs the following tasks:

- **Reruns tests**—Application Manager reruns all of the selected tests to ensure that the issues that it is going to resolve still exist in the current version of the package and its associated transforms.
- **Creates transform files**—To resolve issues, Application Manager generates fix transform files.
- **Reimports packages**—Application Manager then automatically reimports each package and its fix transform files into the Application Catalog.

When issue resolution and reimporting is complete, look at the **Analyze Group View**, **Application View**, or **Deployment Type View** of the package, application, or group that you tested. You will see that the Error With Fix and Warning With Fix icons have been replaced with the status icon with the next highest level (as described in the **Hierarchical Level of Status Icons** section of the **About Status Icons** help topic) in that test category.
Distributing a Repackaged Application

In this procedure, you will distribute a Windows Installer package to a network location.

### Table 10 • Distribute a Repackaged Application

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>9.</td>
<td>Distribute repackaged application</td>
<td>Use the Legacy Distribution Wizard to distribute the Sample Application Windows Installer package to a Network location. You open the Legacy Distribution Wizard by opening the Home tab of the ribbon, selecting the Windows Installer package node and then selecting Distribute Package from the context menu. For instructions on how to distribute a package to a network location, see Distributing Packages to Network Locations.</td>
<td>SampleApplication.msi is copied to the specified network location, making it available to your enterprise.</td>
</tr>
</tbody>
</table>

**Note** • To distribute an application to a System Center 2012 Configuration Manager, Citrix XenApp, Symantec Altiris, JAMF Casper Suite, or AirWatch, select the application node in the tree and then click the Distribute button in the ribbon. You must have already set up a named connection to that distribution system on the Options dialog box.

**Note** • You can publish applications containing App-V 4.x packages and Citrix XenApp profiles to Citrix XenApp server, and can publish applications containing Windows Installer, Symantec Workspace, VMware ThinApp, or legacy installers to Symantec Altiris server.

If an application contains a package of an unsupported deployment type, that package will be ignored.
Migrating to Application Virtualization

The flowchart on the **Migrate to Application Virtualization** tab of the AdminStudio Start page lists the steps you need to perform to migrate your application portfolio into virtual applications that are ready for deployment within the enterprise.

![Flowchart](image)

**Figure 22:** Migrate to Application Virtualization Tab of AdminStudio Start Page

In this section, you will use the Automated Application Converter to convert Windows Installer packages to virtual packages, and then test and distribute the virtual packages.

To migrate your application portfolio into virtual applications, perform the following steps:

- **Identifying Packages to Virtualize**
- **Converting to Virtual Formats**
- **Testing and Distributing Converted Packages**
Identifying Packages to Virtualize

In this procedure, you will import packages into the Application Catalog and identify the packages you want to virtualize.

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Import packages into Application Catalog.</td>
<td>Open Application Manager and locate the packages that you imported in Importing Packages into the Application Catalog.</td>
<td>The four Windows Installer packages are listed in the Application Manager tree:</td>
</tr>
</tbody>
</table>

![Application Manager Tree](image-url)
2. View package’s Application Virtualization Compatibility test results.

To view application virtualization compatibility test results, open the Analyze tab, and then select a group in the tree to open the Analyze Group View.

Test results are also shown in the Application Virtualization Compatibility column under Supportability Risks on the Analyze Group View.

You can switch between chart and list view of clicking the toggle button in the top right corner of the view.

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.</td>
<td>View package’s Application Virtualization Compatibility test results.</td>
<td>To view application virtualization compatibility test results, open the Analyze tab, and then select a group in the tree to open the Analyze Group View.</td>
<td>The packages’ application virtualization compatibility test results are listed in both chart and list view. The following is the chart view:</td>
</tr>
</tbody>
</table>
Table 11 • Identify Packages to Virtualize

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Identify candidates for virtualization.</td>
<td>You will notice that in the <strong>Application Virtualization Compatibility</strong> column, two of the packages have a Ready status (Sample Application Source and Sample Application Target), while the other has an Error status (Sample Kit). Therefore, for the package with the error status, select the deployment type icon in the tree to open the Summary view, and then click on the error status icon under <strong>Application Virtualization Compatibility</strong> next to the unsupported virtualization type.</td>
<td>This <strong>Summary</strong> view lists the virtualization formats that generated the error:</td>
</tr>
</tbody>
</table>

If you click on the error icon in the **Overall Assessment** column, you will see the details of the error:

---

Converting to Virtual Formats

In this procedure, you will use Automated Application Converter to convert Windows Installer packages to App-V packages.

Table 12 • Convert to Virtual Formats

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Import candidate packages into Automated Application Converter.</td>
<td>Open Automated Application Converter, open the existing project you created in <strong>Configuring a Virtual Machine</strong>, and use the <strong>Package Import Wizard</strong> to add the packages that you identified in <strong>Identifying Packages to Virtualize</strong>.</td>
<td>Packages are listed on the <strong>Packages</strong> tab.</td>
</tr>
</tbody>
</table>

**Note** • For instructions, see **Selecting Packages from an AdminStudio Application Catalog**.
5. **Convert to virtual packages.**

First, open the **Project Options** dialog box and make sure that the **Package Creation** property is set to **App-V 4.6 with AdminStudio**.

Then, use the Application Conversion Wizard to convert the packages to App-V 4.x applications.

*Note* • For instructions, see Performing a Conversion Using the Application Conversion Wizard.

*Important* • Make sure that you have already performed the steps in Configuring a Virtual Machine before beginning this step.

When conversion is complete, each virtual package is listed in a tree structure under its original package on the Packages tab.

6. **Test launch virtual packages.**

Test the virtual packages by launching them on a virtual machine.

*Note* • For instructions, see Performing Automated Testing of App-V Packages.

Virtual packages launch successfully.

7. **Publish virtual packages to Application Catalog.**

Import the new virtual packages into the Application Catalog.

*Note* • For instructions, see Importing a Single Package File.

The virtual packages are listed in the Application Manager tree under their associated Application.

*Note* • You may need to click Ctrl + R to refresh the Application Catalog tree.
Testing and Distributing Converted Packages

In this procedure, you will validate the converted packages, perform conflict analysis against other packages, resolve any issues found, and distribute the packages.

Table 13 • Test and Distribute Converted Packages

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>8.</td>
<td>Perform virtualization best practices testing.</td>
<td>By default, App-V best practices testing is performed during import (as described in Import Options). To perform this testing manually, first select the Analyze tab in the Application Manager ribbon. Then, select one of the App-V packages in the Application Manager tree, and click Execute Tests. Messages appear in the Output Window.</td>
<td>When testing is complete, results are displayed on the Summary tab of the Analyze Deployment Type View.</td>
</tr>
<tr>
<td>9.</td>
<td>Perform conflict testing.</td>
<td>In Application Manager, perform conflict testing of the Sample Application Source App-V package against the Sample Application Target App-V package.</td>
<td>Conflict analysis results are listed in the Output window and in the Conflicts view. An error is detected: Package ‘Sample Application Source’ has a conflicting root Directory ‘SampleAp.100’ with package ‘Sample Application Target’.</td>
</tr>
<tr>
<td>10.</td>
<td>Edit App-V packages (if necessary).</td>
<td>To resolve the error that was found during testing on Sample Application Source App-V package, select it on the Home tab of the Application Manager tree and select Edit with Virtual Package Editor. In the Virtual Package Editor’s General Information view, change the Root Folder Name property to SampleAp.200 and click Save.</td>
<td>The edited App-V package is imported into the Application Catalog. Note • When you rerun the conflict testing that you ran in the previous step, no error will be generated.</td>
</tr>
</tbody>
</table>

Note • For more information, see Performing Compatibility, Best Practices, and Risk Assessment Testing.

Note • For instructions, see Testing for Conflicts Between Packages.

Note • For instructions, see Using the Virtual Package Editor.
Testing for Application Compatibility

The flowchart on the Test for Application Compatibility tab of the AdminStudio Start page outlines how to use Application Manager to test packages for compatibility with the latest versions of Windows and Windows Server operating systems, as well as to test web applications for compatibility with Internet Explorer 11 and Microsoft Edge.

Figure 23: Test for Application Compatibility Tab of AdminStudio Start Page

In this section, you will test some packages for operating system compatibility fix issues that were found. You will also test web applications, both statically and dynamically.

To perform application compatibility testing, perform the following steps:

1. Distribute to enterprise for user acceptance testing and production.

Distribute this tested App-V package to a Network location.

Note • For instructions on how to distribute a package, see Distributing Packages to Network Locations.

Tip • Distribution Wizard also supports deploying applications to System Center Configuration Manager (Current Branch), System Center 2012 Configuration Manager, System Center 2007 Configuration Manager, Citrix XenApp Server, JAMF Casper Suite, AirWatch Server, Microsoft App-V Server, and Symantec Altiris distribution systems. For more information, see Distributing Applications.

### Table 13 • Test and Distribute Converted Packages

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Results</th>
</tr>
</thead>
<tbody>
<tr>
<td>11</td>
<td>Distribute to enterprise for user acceptance testing and production.</td>
<td>Distribute this tested App-V package to a <strong>Network</strong> location.</td>
<td>The selected App-V package is copied to the specified network location, making it available to your enterprise.</td>
</tr>
</tbody>
</table>

| Note • For instructions on how to distribute a package, see Distributing Packages to Network Locations. |
| Tip • Distribution Wizard also supports deploying applications to System Center Configuration Manager (Current Branch), System Center 2012 Configuration Manager, System Center 2007 Configuration Manager, Citrix XenApp Server, JAMF Casper Suite, AirWatch Server, Microsoft App-V Server, and Symantec Altiris distribution systems. For more information, see Distributing Applications. |
● Importing Packages, Web Applications, and Mobile Apps
● Selecting Tests to Run and Setting Default Fix Option
● Performing Testing and Viewing Results

Importing Packages, Web Applications, and Mobile Apps

In this procedure, you will load the packages to test and select the reports to run.

Table 14 • Importing Packages and Web Applications

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Import Windows Installer packages into Application Catalog.</td>
<td>For this exercise, we will test Windows Installer packages that were imported into the Application Catalog earlier in this guide in Importing Packages into the Application Catalog.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>The Application Manager tree should now be organized as follows:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td><img src="image" alt="Application Manager Tree" /></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong> • For instructions on how to import a directory of packages into the Application Catalog, see Importing a Folder of Multiple Packages.</td>
<td></td>
</tr>
<tr>
<td>2.</td>
<td>Import web applications into Application Catalog.</td>
<td>First, open the Import Options &gt; General tab of the Application Manager Options dialog box, and clear the selection of the Automatically Execute Tests After Import option.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Next, create a new group in the Application Manager tree named Web Applications.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Then import the following web applications into the Web Applications folder, as described in Importing a Deployed Web Applications.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Orbitz at: <a href="http://www.orbitz.com">http://www.orbitz.com</a></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Travelocity at: <a href="http://www.travelocity.com">http://www.travelocity.com</a></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Because these web applications do not require a login to access, leave the User name and Password fields on the Web Site Details panel blank.</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>The web applications are listed in the Application Manager tree:</td>
<td><img src="image" alt="Web Applications Tree" /></td>
</tr>
</tbody>
</table>
In this procedure, you will select the Operating System Compatibility and Browser Compatibility tests to run and set default fix options.

### Table 15 • Selecting Tests to Run and Setting Default Fix Option

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>4</td>
<td>Select the operating system and browser compatibility tests that you want to run.</td>
<td>Select the <strong>Operating System Compatibility</strong> and <strong>Browser Compatibility</strong> tests that you want to run, as described in Selecting Tests to Execute.</td>
<td>The <strong>Operating System Compatibility</strong> and <strong>Browser Compatibility</strong> tests that you want to run are selected on the <strong>Select Tests to Execute</strong> dialog box.</td>
</tr>
</tbody>
</table>

*TIP* • To speed up testing, it is recommended that you select just the operating systems and browser versions that are being used in your organization.
Performing Testing and Viewing Results

In this procedure, you will test packages and web applications for operating system and browser compatibility, view test results, and automatically fix issues.

Table 15 • Selecting Tests to Run and Setting Default Fix Option

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Result</th>
</tr>
</thead>
</table>
| 5. | Set the default fix option for selected tests: basic fix, advanced fix, or do not fix. | Some of the tests in the Operating System Compatibility and Browser Compatibility test group let you specify whether to perform a basic or advanced fix when you automatically resolve issues, as described in Setting Automatic Fix Preferences for Operating System Compatibility and Browser Compatibility Tests. | A Default Fix selection is made for all Operating System Compatibility and Browser Compatibility tests.  
Default Fix:  
This choice will be used when resolving the issues that are identified by this test.  
☐ Do not resolve this issue automatically.  
☐ Apply the basic auto fix.  
☐ Apply the advanced auto fix. |

On the Select Tests to Execute dialog box, review the Default Fix section of several of your selected tests. For this exercise, it is not necessary to make any changes to the Default Fix settings.

Table 16 • Performing Testing and Viewing Results

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Result</th>
</tr>
</thead>
</table>
| 6. | Click Execute Tests to test Windows Installer packages, mobile apps, and web applications (statically). | First select the Analyze tab in the Application Manager ribbon  
Then, select the Applications group in the Application Manager tree, and click Execute Tests. | Messages are listed in the Output Window. When testing is complete, the following message is displayed:  
Testing finished at: Monday, April 23, 2018 - 13:47:04  
Tested 6 packages of 6. |

Note • For more information, see Performing Compatibility, Best Practices, and Risk Assessment Testing.
Click Launch Web Test to test web applications interactively.

To interactively, dynamically test a web application, select a web application node in the tree and click Launch Web Test.

Note • For more information, see Performing Dynamic Testing of Web Applications.

Application Manager launches the web application in your browser. Then, as you perform tasks and navigate around the web application, Application Manager records any warnings or errors that are encountered while using that version of the browser.

When you have finished testing, close the browser window.

Tip • You should always use dynamic testing when a web application requires a login to access.

Tip • As each page loads, Application Manager begins testing. Links on each page do not become active until testing is complete on that page, so you may have to wait several seconds before proceeding.

Table 16 • Performing Testing and Viewing Results

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.</td>
<td>Click Launch Web Test to test web applications interactively.</td>
<td>To interactively, dynamically test a web application, select a web application node in the tree and click Launch Web Test.</td>
<td>Messages are listed in the Output Window. When testing is complete, the following message is displayed: Testing finished at: Monday, April 23, 2018 - 13:58:08 Completed testing package(s).</td>
</tr>
</tbody>
</table>
8. **View test results.** When testing is finished, view the test results by selecting a Windows Installer package or web application in the tree to open the **Summary** view of the **Supportability Risks** of the **Analyze Deployment Type View**.

Click an icon in the Overall Assessment column to view detailed test results:

![Summary view](image)

Click the Suppress (ON/OFF) button to suppress any issues that are not important to your organization.

*Note* • For more information, see Viewing Operating System Compatibility Test Results and Viewing Browser Compatibility Test Results.

---

**Table 16 • Performing Testing and Viewing Results**

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>8.</td>
<td>View test results.</td>
<td>When testing is finished, view the test results by selecting a Windows Installer package or web application in the tree to open the <strong>Summary</strong> view of the <strong>Supportability Risks</strong> of the <strong>Analyze Deployment Type View</strong>.</td>
<td></td>
</tr>
</tbody>
</table>

![Detailed test results](image)

Click an icon in the Overall Assessment column to view detailed test results:

![Detailed test results](image)

Click the Suppress (ON/OFF) button to suppress any issues that are not important to your organization.

*Note* • For more information, see Viewing Operating System Compatibility Test Results and Viewing Browser Compatibility Test Results.
Table 16 • Performing Testing and Viewing Results

<table>
<thead>
<tr>
<th>#</th>
<th>Step</th>
<th>Instructions</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>9.</td>
<td>Click Resolve Issues to automatically resolve issues.</td>
<td>Issues for which automatic fixes are available are identified by the Error With Fix or Warning With Fix icon:</td>
<td></td>
</tr>
</tbody>
</table>

![Error and Warning Icon]

To automatically resolve all issues for which automatic fixes are available, select the Applications group node in the tree and click Resolve Issues in the Analyze tab of the ribbon.

![Application Manager Tree]

Note • For more information, see Performing Automatic Issue Resolution.

Issue resolution begins, progress messages appear in the Output window, and Application Manager performs the following tasks:

- **Reruns tests**—Application Manager reruns all of the selected tests to ensure that the issues that it is going to resolve still exist in the current version of the package and its associated transforms.

- **Creates transform files**—To resolve issues, Application Manager generates fix transform files.

- **Reimports packages**—Application Manager then automatically reimports each package and its fix transform files into the Application Catalog.

When issue resolution and reimporting is complete, look at the Analyze Group View, Application View, or Deployment Type View of the package, application, or group that you tested. You will see that the Error With Fix and Warning With Fix icons have been replaced with the status icon with the next highest level (as described in the Hierarchical Level of Status Icons section of the About Status Icons help topic) in that test category.